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Chapter 1 Introduction

Congratulations on purchasing this digital camera. Your digital 
camera is compact and ergonomic and capable of taking pictures 
at resolutions as high as 12 megapixels (4032 x 3024 pixels, extrap-
olated resolution). The digital camera can also record movies and 
has an 8× digital zoom.

Features
• Compact, stylish design
• Digital zoom 8×
• 5.0 megapixel high-resolution CMOS (2592 × 1944 

pixels)
• Maximum resolution 12 megapixels (4032 x 3024 

pixels, extrapolated resolution)
• Video capture resolution of 320 × 240, 30 fps; 

640x480, 24fps
• Convenient 1.5-inch LCD
• Voice memo
• Supports SD card media
• Built-in 32 MB memory
• Self-timer mode
• Continuous shooting mode
• USB 2.0 port full speed
• TV output
• Built-in microphone and speaker
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Package contents

Make sure that your package contains the following components. If 
anything is missing or damaged, contact your dealer immediately. 
Retain the packaging in case you need to ship the digital camera in 
the future.

• Digital camera
• Hand strap
• Quick start guide
• User manual (on CD)
• AA batteries × 2
• USB cable
• CD-ROM including drivers and software
• Audio/Video cable

Camera overview

Familiarize yourself with the controls of the digital camera with the 
illustrations below.

Front view

Lens

Flash

LED

MIcrophone
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Rear View

Side Views

Zoom 

buttons
Voice button

LCD

Menu 
button

Zoom 

buttons

Zoom 

buttons

5-way 
button

LCD button

Mode button

Focus button

Right Left

TV output jack USB 
port

Hand strap 
eyelet
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Top View

Bottom View

Shutter 
button
Power 
button

Speaker

Battery/SD 
card 
compartment

Tripod
mount



Chapter 2 Getting Started

Attaching the hand strap.
1. Thread the short loop of the hand strap 

through the hand strap eyelet on the 
camera

2. Thread the long loop of the hand strap 
through the short loop.

3. Pull the long loop tight.

Inserting the batteries
1. Slide the battery/memory card cover 

on the underside of the camera in 
the direction of the arrow.

2. Open the cover.

3. Insert the batteries into the 
compartment observing correct 
polarity.

4. Close the cover and snap it into place 
in the direction of the arrow.

O
P
E
N

O
P
E
N
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Turning the camera on and off

Press the Power button on top of the camera to turn camera on.

Press the Power button again to turn the camera off.

Inserting an SD card
1. Slide the battery/memory card cover 

on the underside of the camera in the 
direction of the arrow.

2. Open the cover.

3. Insert the SD card into the slot, with 
the label facing the same direction as 
the front of the camera until it clicks 
into place.

Note: SD cards can only be inserted facing one 
direction. If the card does not enter the slot 
easily, do not force it. Make sure the card is 
facing the correction direction.

4. Close the cover then snap it into place 
in the direction of the arrow.

Power button

O
P
E
N

O
P
E
N
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Using the LCD display

The LCD functions as a view finder, allowing you to frame pictures 
and video in Picture or Video mode, and view pictures and videos in 
Playback mode. The LCD allows you to adjust the camera’s settings 
through the on-screen menus.

The LCD displays icons to indicate camera settings.

Changing LCD settings

The LCD starts in normal setting. In Picture or Video mode:

• Press the LCD button once to turn on the red fram-
ing grid.

• Press the LCD button again to turn off the framing 
grid and icons.

• Press the LCD button again to turn off the LCD.
• Press the LCD button again turn the LCD on and 

display the icons.
In Playback mode:

• Press the LCD button to turn off the icons.
• Press the LCD button again to turn off the LCD.
• Press the LCD button again to turn the LCD on and 

display the icons.

LCD button
7
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Understanding the LCD icons

Each mode has different icons to indicate settings.

Picture mode

Playback mode

Remaining number 
of pictures you can 
take on the current 
memory

Indicates that 
there is insufficient 
light to prevent 
blurring.

Current time

Image qualityResolutionFlash icon

Picture mode icon
Scene setting icon

Zoom

Battery status icon

EV adjust setting Focus bracket

Current file 
number/total files

Resolution

Battery status icon

File type

Protection icon

DPOF icon



 Chapter 2 Getting Started

U
si

n
g

 t
h

e 
LC

D
 d

is
p

la
y

Video mode

Video mode icon

Zoom

Battery status icon

Video resolution

Video length

Recording icon

Current time

Focus bracket
9



Chapter 3 Taking still images or videos

Selecting the camera mode

The digital camera has two capture modes: Picture and Video. Use 
Picture mode to capture still images and audio. Use Video mode to 
capture video and audio.

Use the third mode, Playback mode, to view pictures and videos, 
and listen to audio.

Use the Mode switch to change modes.

• Move the switch to the left to select Video mode.
• Move the switch to the center to select Playback 

mode.
• Move the switch to the right to select Picture mode.

Taking pictures
1. Turn the camera on. 

Make sure the camera is 
in Picture mode.

2. Frame the picture using 
the LCD.

3. Press the Shutter 
button. 

Mode switch
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Adjusting the camera settings using the camera buttons

You can use adjust the camera settings to take better pictures.

Using the digital zoom

The camera has an 8× digital zoom, allowing you to take enlarge 
the subject without moving closer.

1. Turn the camera on. Make sure the camera is in Picture or 
Video mode.

2. Frame the picture using the LCD.
3. Press the Zoom in button to 

increase the zoom and take a 
close up picture of the subject 
with more detail. Press the 
Zoom out button to decrease 
the zoom and take a wider pic-
ture with less detail.

4. Press the Shutter button to 
take the picture.

Using the flash

The flash has three settings for different lighting conditions. Move 
the 5-way button left repeatedly to cycle through the different flash 
settings.

Icon Description

Flash is fired automatically if required.

Flash is enabled.

Flash is disabled.
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Using the self-timer

The self-timer allows you to take hands-free pictures and videos 
such as self portraits or group photos.

1. Turn the camera on. Make sure the camera is in Picture 
mode.

2. Set the camera on a stable surface such as a tripod or table 
and frame the picture.

3. Frame the picture, making any zoom or flash settings nec-
essary

4. The self-timer has two delay set-
tings.
Press the Right arrow once turn 
on the self-timer with a two sec-
ond delay. The icon appears.
Press the Right arrow again to 
set the delay to 10 seconds. The 
icon appears.

5. Press the Shutter button. The 
counter begins counting down 
on the LCD. The LED on the front of the camera flashes 
once a second to count down.

Note: To cancel the self timer, press the Right button until no icon is 
displayed.

Taking sequences

You can take sequences of pictures very quickly one after the other 
using the sequence setting. You can use this to make an action 
series.

1. Turn the camera on. Make sure the camera is in Picture 
mode.

2. Press the Right arrow three 
times to turn on the Sequence 
setting. The icon appears.

3. Frame the picture using the 
LCD.

4. Press the Shutter button.
13
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Changing the focus setting

You can change the focus setting of the digital camera for different 
conditions. Change the setting using the Focus switch.

Recording videos
1. Turn the camera on. Make sure 

the camera is in Video mode.
2. Frame the picture using the 

LCD.
3. Press the Shutter button. The 

video begins to record.
4. Press the Shutter button when 

you have finished to stop 
recording.

Icon Description

Adjusts the focus setting for 
subjects close to the lens.

Adjusts the focus setting for 
subjects distant from the lens
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Adjusting the camera settings using the menus

You can adjust settings using the on-screen menu. This enables you 
to configure the camera settings and capture pictures with 
optimum quality.

Note: The LCD must be switched on to access the on-screen menu.

Using the scene settings

Use this menu item to specify a setting according to the light 
environment in which you are taking pictures. To set the scene, do 
the following:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu (Video 
menu in Video mode).

4. Move the 5-way button up or down to 
highlight the Scene submenu.

5. Move the 5-way button right to open 
the Scene menu

6. Move the 5-way button up or down to 
select from the scene options: 
– Auto
– Portrait
– Scenery
– Night scene
– Motion
– Couple shot
– Sepia
– B/W
– Pink
– Green
– Blue

7. Press OK when finished.
Note: In video mode, only Auto, Sepia and B/W scene options are available.
15
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Setting the resolution

Use this menu item to select the resolution of the image as follows:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu.
4. Move the 5-way button up or down to 

highlight the Resolution submenu.
5. Move the 5-way button right to open 

the Resolution submenu
6. Move the 5-way button up or down to 

select from the scene options: 
– 5.0M
– 3.1M
– 1.3M
– VGA

7. Press OK when finished.

Setting the date stamp

The date stamp menu enables you to imprint the time and the date 
on the image. To set the date stamp, do the following:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu.
4. Move the 5-way button up or down to 

highlight the Date stamp submenu.
5. Move the 5-way button right to open 

the Date stamp menu.



 Chapter 3 Taking still images or videos

A
d

ju
st

in
g

 t
h

e 
ca

m
er

a 
se

tt
in

g
s 

u
si

n
g

 t
h

e 
m

en
u

s

6. Move the 5-way button up or down to 
select from the date stamp options: 
– Date and time
– No stamp
– Only date
– Only time

7. Press OK when finished.

Setting the white balance

The white balance enables you to change the preset white balance 
setting to suit the lighting conditions in which the picture is taken.

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu.
4. Move the 5-way button up or down to 

highlight the White balance 
submenu.

5. Move the 5-way button right to open 
the White balance submenu.

6. Move the 5-way button up or down to 
select from the date stamp options: 
– Auto
– Daylight
– Cloudy
– Tungsten
– Fluorescent

7. Press OK when finished.
17
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Setting the EV adjust

The EV adjust menu enables you to set the amount of light that 
enters the camera while taking the picture. The EV compensation is 
expressed as a single number that is used by the digital camera to 
calculate the correct combination of aperture and shutter speed for 
producing optimum quality pictures. Setting a higher EV compen-
sation value will over-expose a shot while setting a lower value will 
under-expose a shot. Exposure can be adjusted from –2.0 to +2.0. 
The value is shown on the LCD display. To change the EV compen-
sation value, do the following:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu.
4. Move the 5-way button up or down to 

highlight the EV adjust submenu.
5. Move the 5-way button right to open 

the EV adjust submenu.
6. Move the 5-way button up or down to 

adjust the EV value between -2.0 
through +2.0. Select Normal for the 
default value. 

7. Press OK when finished.
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Setting the encircled exposure

Use the following procedure to set the encircled exposure:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu.
4. Move the 5-way button up or down to 

highlight the Encircled exposure 
submenu.

5. Move the 5-way button right to open the 
Encircled exposure submenu.

6. Move the 5-way button up or down to 
select one of the following values: 
– 0.3EV
– 0.5EV
– 1.0EV

7. Press OK when finished.
19
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Setting the quality

Do the following to specify the image or video quality:

1. Turn on the camera and switch to picture or video mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Capture menu (Video 
menu in Video mode).

4. Move the 5-way button up or down to 
highlight the Image quality 
submenu in the picture mode or Video Quality submenu 
in the video mode.

5. Move the 5-way button up or down to 
select from the quality options: 

• Picture mode
– Basic 1:16
– Better 1:12
– Best 1:8

• Video mode
– CIF 20fps
– CIF 30fps
– VGA 15fps
– VGA 24fps

6. Press OK when finished.
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Customizing the camera

You can customize the camera according to your preferences. Refer 
to the following sections for more information.

Enabling sound effect

Do the following to enable the sound effect:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Sound effect submenu.
5. Move the 5-way button right to open 

the Sound effect submenu.
6. Move the 5-way button up or down to 

select On to enable the sound effect 
or Off to disable the sound effect.

7. Press OK when finished.

Setting the welcome picture

Use the following procedure to specify the welcome picture shown 
when the camera is turned on.

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Welcome submenu.
5. Move the 5-way button right to open 

the Welcome submenu
6. Move the 5-way button up or down to 

select one of the following options:
– Auto
– Off
– Custom pic

7. Press OK when finished.
21



C
u

sto
m

izin
g

 th
e cam

era

User Manual

22
Setting the USB options

Use this option to specify whether the camera is used for storage or 
as a web camera when connected to the PC. Refer to “Changing the 
USB setting” on page 42 for more details.

Setting the date and time

Use this option to set the date and time as follows:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Date and time 
submenu.

5. Move the 5-way button right to open the Date and time 
submenu.

6. Move the 5-way button left or right to 
move between the various date (yy/
mm/dd) and time (hh:mm) fields. 

7. Move the 5-way button up or down to 
change the various date and time 
fields.

8. Press OK when finished.

Setting the TV out

Use this option to specify the TV out format. See “Setting the out-
put mode” on page 43 for more information.
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Setting the frequency

Use the frequency menu to set the frequency of the camera. This 
value should be the same as the frequency of the power supply at 
the location where you are using the camera. This prevents lights 
flickering when taking pictures or video.

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Frequency submenu.
5. Move the 5-way button right to open 

the Frequency submenu.
6. Move the 5-way button up or down to 

select 50Hz or 60Hz.
7. Press OK when finished.
23
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Setting the auto power off function

The auto power off function turns off power automatically after a 
specified period in order to conserve power. Use the following pro-
cedure to set the auto power off interval.

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Auto power off 
submenu.

5. Move the 5-way button right to open
the Auto power off submenu.

6. Move the 5-way button up or down to 
select from one of the following 
options:
– 1 minute
– 2 minutes
– 5 minutes
– Never

7. Press OK when finished.

Setting the language

To set the menu language, do the following:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Language submenu.
5. Move the 5-way button right to open 

the Language submenu.
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6. Move the 5-way button up or down to 
select from one of the following 
options:
– English
– German
– French
– Italian
– Spanish
– Dutch
– Czech
– Polish
– Russian
– Traditional Chinese
– Simplified Chinese
– Korean
– Japanese
– Bulgarian
– Portuguese

7. Press OK when finished.
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Restoring defaults

Use the setup menu to restore the camera settings to their default 
values as follows:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Default submenu.
5. Move the 5-way button right to open 

the Default submenu.
6. Move the 5-way button up or down to 

select Confirm to reset the camera or 
Cancel to cancel the operation.

7. Press OK when finished.

Formatting the memory

Use the following procedure to format the camera’s memory:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Setup menu.
4. Move the 5-way button up or down to 

highlight the Format submenu.
5. Move the 5-way button right to open 

the Format submenu.
6. Move the 5-way button up or down to 

select Confirm to format the memory 
or Cancel to cancel the operation.

7. Press OK when finished.
The camera memory is formatted and all the 
files including the protected files are deleted.

Warning: Formatting memory will cause all files stored in memory to be erased. 
Make sure you have backed up any files you want to keep.
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Playing games on the camera screen

The digital camera provides the additional features of three games 
that you can play using the camera buttons and LCD screen. To 
select a game, do the following:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Games menu.
4. Move the 5-way button up or down to 

highlight one of the following games:
– Magic beads
– Lucky 777
– Lottery

5. Move the 5-way button right to select the game and start 
playing.

6. Press Menu to stop the game at any time.
27



Chapter 4 Reviewing photos or movie clips

Move the Mode switch to 
center to switch to playback 
mode.

The LCD screen displays the 
most recent image. If the 
most recent file is a video 
clip, it displays the first frame of the movie clip on the screen. No 
image is displayed if the most recent file is an audio file.

Mode switch

Image file Video file Audio file
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To browse through your images and video or audio clips, do the 
following:

1. Move the 5-way button right or left to skip to the next or 
previous file. 

2. If the file is a video clip, press OK to 
start playing the video clip. Press OK 
to stop playback. Playback status is 
displayed on the screen, along with 
the playback icon.

3. If the file is an audio clip, press OK to 
start playing the audio clip. Press OK 
to stop playback. Playback status is displayed on the 
screen, along with the playback icon.

4. You can attach a voice memo to an image by pressing the 
Voice button. Press the button again to stop recording. To 
play back the voice memo, press the OK button. To learn 
about deleting the voice memo, see “Deleting a voice 
memo” on page 34.

Zooming in

You can use the digital zoom feature to zoom 
in and examine the fine details of the picture. 
Press the Zoom in button to magnify the 
image and the Zoom out button to decrease 
the zoom ratio. The zoom ratio is indicated by 
the zoom window over the thumbnail image 
at the lower right corner of the screen.

The magnified image is initially centered on 
the LCD. To pan the view and see different 
parts of the magnified image, move the 5-way 
button left, right, up, or down. The lower right 
corner shows the thumbnail image along with 
the zoom area highlighted.
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Deleting files

In playback mode, you can easily delete any pictures or audio/video 
clips that you are not satisfied with, before transferring them to the 
PC. To delete unwanted files, do the following:

1. In playback mode, use the 5-way button to browse to the 
image or audio/video clip that you want to erase.

2. Move the 5-way button down to dis-
play the Erase menu.

3. Using the 5-way button, select one of 
the following options:
– All: erases all files.
– Current: erases the currently 

selected file.
– Cancel: cancels the delete operation.

4. Press OK to confirm the operation.
The selected files are deleted.

Protecting files

To lock images or audio/video clips in order to prevent them from 
being deleted accidentally, do the following:

1. In playback mode, use the 5-way button to browse to the 
image or audio/video clip that you want to protect.

2. Move the 5-way button up to display 
the Protect menu.

3. Using the 5-way button, select one of 
the following options:
– Current
– All
– Cancel

4. Press OK to confirm the operation.
The selected files are protected.

If the selected file is previously protected, the Unprotect menu is 
displayed when you move the 5-way button up. Remove the lock if 
required in a manner similar to protecting the image.
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Editing images

The playback menu has various options to enable you to edit 
pictures by resizing, cropping, or rotating. Refer to the following 
sections for more details.

Resizing images

To resize an image, do the following:

1. In playback mode, use the 5-way button to browse to the 
image that you want to resize.

2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Edit menu.
4. Move the 5-way button up or down to 

highlight the Resize submenu.
5. Move the 5-way button right to open 

the Resize submenu.
6. Move the 5-way button up or down to 

select from the resize options: VGA, 
1.3M, 3.1M, or 5.0M.

7. Press OK when finished.

Rotating images

To rotate an image, do the following:

1. In playback mode, use the 5-way button to browse to the 
image that you want to rotate.

2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Edit menu.
4. Move the 5-way button up or down to 

highlight the Rotate submenu.
5. Move the 5-way button right to open 

the Rotate submenu.
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6. Move the 5-way button up or down to 
select one of the following options:
– Rotate
– Save
– Cancel

7. Press OK when finished.

Cropping files

The cropping feature enables you to cut off unwanted parts of the 
picture. To crop an image, do the following:

1. In playback mode, use the 5-way button to browse to the 
image that you want to crop.

2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Edit menu.
4. Move the 5-way button up or down to 

highlight the Crop submenu.
5. Move the 5-way button right to open 

the Crop submenu.
6. Move the 5-way button up or down to 

select one of the following options:
– 4:3
– 3:2

7. Move the 5-way button right to start 
cropping.

8. The cropping window is displayed on 
the image. Use the 5-way button to 
move the cropping window and 
select the area to be cropped.

9. Press OK when finished.
33



D
eletin

g
 a vo

ice m
em

o

User Manual

34
Deleting a voice memo

You can use the playback menu to delete a voice memo attached 
to an image. To delete a voice memo, do the following:

1. In playback mode, use the 5-way button to browse to the 
desired image with a voice memo.

2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Edit menu.
4. Move the 5-way button up or down to 

highlight the Voice Memo submenu.
5. Move the 5-way button to open the 

Voice memo submenu.
6. Select Delete to delete the voice 

memo attached to the image or select 
Cancel to cancel the operation.

7. Press OK when finished.
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Using the slideshow function

The slideshow feature of the camera enables you to view all the 
images automatically on the LCD screen. You can set the slideshow 
interval, direction, etc. and customize the slideshow as required.

Note: Audio/video clips are not played back during the slide show. The first 
frame of the video clips are displayed during the slide show.

Refer to the following sections to set up a slide show.

Setting the starting point

To specify the starting point of the slide show, do the following:

1. Press Menu.
2. Move the 5-way button left or right to 

navigate to the Slide menu.
3. Move the 5-way button up or down to 

highlight the Show submenu.
4. Move the 5-way button right to open 

the Show submenu.
5. Move the 5-way button up or down to 

select one of the following options:
– From current
– From first
– From last

6. Press OK when finished.
35
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Setting the slideshow interval

To set the interval between consecutive images during the slide 
show, do the following:

1. Press Menu.
2. Move the 5-way button left or right to 

navigate to the Slide menu.
3. Move the 5-way button up or down to 

highlight the Interval submenu.
4. Move the 5-way button right to open 

the Interval submenu.
5. Move the 5-way button up or down to 

select one of the following options for 
the interval:
– 1 sec
– 3 sec
– 5 sec

6. Press OK when finished.

Setting the direction

To specify the order in which the slide show displays the images, do 
the following:

1. Press Menu.
2. Move the 5-way button left or right to 

navigate to the Slide menu.
3. Move the 5-way button up or down to 

highlight the Direction submenu.
4. Move the 5-way button right to open 

the Direction submenu.
5. Move the 5-way button up or down to 

select one of the following options:
– Backward
– Forward

6. Press OK when finished.
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Repeating the slideshow

To loop the slideshow repeatedly, do the following:

1. Press Menu.
2. Move the 5-way button left or right to 

navigate to the Slide menu.
3. Move the 5-way button up or down to 

highlight the Repeat submenu.
4. Move the 5-way button right to open 

the Repeat submenu.
5. Move the 5-way button up or down to 

select Yes to repeat the slideshow or 
No to display the slide show only 
once.

6. Press OK when finished.

Starting the slideshow

After setting up the slide show, you are now ready to start the slide 
show. To start the slide show, do the following:

1. Press Menu.
2. Move the 5-way button left or right to 

navigate to the Slide menu.
3. Move the 5-way button up or down to 

open the Play submenu.
4. Press OK.

The slide show starts. Press the OK button at 
any time to stop the slide show.
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Ordering prints

You can set up printing information for printing the digital images 
taken with your digital camera. Refer to the following sections for 
more information:

Using DPOF

The DPOF (Digital Print Order Format) refers to a format that is used 
for recording the print specifications of images. Use the following 
procedure to set the DPOF information for a selected image.

1. In playback mode, use the 5-way button to browse to the 
desired image.

2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Print menu.
4. Move the 5-way button up or down to 

highlight the DPOF submenu.
5. Move the 5-way button right to open 

the DPOF submenu.
6. Use the 5-way button to select Cur-

rent to set the DPOF information for 
the current image or Reset to clear 
the DPOF information for the image.

7. Press OK.

The DPOF information is stored with the 
image as indicated by the DPOF icon. This 
information enables you to take prints for the 
image from a DPOF-compatible printer.
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Using Direct-Print (PictBridge)

You can also connect a PictBridge printer to the digital camera using

the USB port and make prints directly. To set the number of prints for

an image, do the following:

1. In playback mode, use the 5-way button to browse to the 
desired image.

2. Press Menu.
3. Move the 5-way button left or right to 

navigate to the Print menu.
4. Move the 5-way button down to 

highlight the Direct-Print submenu.
5. Move the 5-way button right to open 

the Direct-Print submenu.
6. Use the 5-way button to select 

Current to print the current image or 
Cancel to cancel the operation.

7. Press OK.
          8. Use the 5-way button to select the 

          Copies option and set the number of 
          copies to be printed by moving the 
          button left or right. 

          9.   Select the Print option and press OK.
                You will see the message: "Please
                connect printer!"

   10. Connect the camera to your printer. 
                Your image should start printing at this
                 time.     
39



Chapter 5 Connecting to a PC or TV

This chapter describes how to connect the digital camera to a TV 
for reviewing your pictures and videos, or to a PC to transfer your 
files. 

Connecting to a PC

You can connect the camera to your PC and transfer your images to 
the PC using the USB port. You can also use the camera as a web 
camera and use it for video conferencing. Refer to the following 
sections for more information.

Installing the software

The software CD provided with the digital camera contains the soft-
ware driver required to use the camera as a web camera and to 
transfer data from it. It also contains various software applications 
to help you view and edit your digital photos and videos. To install 
the software, do the following:

1. Insert the CD into your PC’s CD drive. The CD menu 
is displayed.

2. Select one of the following options:
– Digital Camera Driver 
– Ulead Photo Explorer 8.0SE
– Ulead Video Studio 7.0SE
– Ulead Cool 360
– User Manual

3. Click Install to start the installation. Follow the 
instructions on the screen to complete the installa-
tion.
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Changing the USB setting

You can use the camera as a storage device and transfer the photos 
to the PC. You can also use it as a web camera for video conferenc-
ing. To configure the USB setting, do the following:

1. In picture mode, press Menu to dis-
play the menu.

2. Move the 5-way button left or right to 
navigate to the Setup menu.

3. Move the 5-way button up or down to 
highlight the USB submenu.

4. Move the 5-way button right to open 
the USB submenu.

5. Move the 5-way button up or down to 
select one of the following options:
– Storage
– PC camera

6. Press OK when finished.

Connecting the USB cable

To connect the camera to the PC, do the following:

1. Turn on the camera. 
2. Connect the digital 

camera to the computer 
with the USB cable. 

3. The LCD screen displays 
Storage or PC camera 
and turns off. All camera 
buttons are disabled.
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Connecting to a TV

You can connect the digital camera to a TV and use the TV screen to 
review your images and play back your video clips.

Setting the output mode

Before connecting the camera to a TV, you need to set the TV out-
put mode and make sure it matches that of your TV. to set the TV 
output mode, do the following:

1. In picture mode, press Menu to dis-
play the menu.

2. Move the 5-way button left or right to 
navigate to the Setup menu.

3. Move the 5-way button up or down to 
highlight the TV out submenu.

4. Move the 5-way button right to open 
the TV out submenu.

5. Move the 5-way button up or down to 
select the NTSC or PAL option.

6. Press OK when finished.
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Viewing images on the TV

To view images and videos on the TV, do the following:

1. Turn the camera on and 
set it to playback mode 
using the mode switch.

2. Connect the TV out jack 
on your digital camera to 
the audio / video input 
ports on your TV using the 
AV cable provided. The 
LCD screen turns off.

3. Use the procedures 
described in “Reviewing 
photos or movie clips” on 
page 29 to play back the 
files on your camera.

AudioVideo



Appendix

Specifications

Image sensor 1/1.8-inch CMOS

Resolution
Extrapolated 
resolution

5 megapixels (2592 × 1944 pixels)
12 megapixels

Shutter speed 1/6 ~ 1/1000 second

Zoom 8× digital zoom

LCD 1.5-inch TFT

Internal memory       32 MB SDRAM

Supported media Secure Digital card

Format:
Image
Video
Audio

JPEG/EXIF 2.1/DPOF
AVI (CIF)
WAV

Connections USB 2.0
TV (Audio/Video) out

Power 2 × AA batteries

Weight 85 g
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Error Messages

Error Message Possible causes Solutions

Card Full The card is full, and no 
more files can be stored 
on the card.

Delete some files or insert 
another card.

Write-Protect Card has been write 
protected.

Move the card’s write protect 
switch to turn off write protection

Card Error • The card maybe 
damaged.

• The card may require 
formatting.

• Format the card
• Insert another card.

Picture Error The picture cannot be 
viewed with the camera

View the image on a computer. If 
the picture cannot be viewed, the 
file may be damaged.

No picture No files exist in the 
memory or on the card

• Take pictures or video.
• Insert another card.

Card Setup The card is not formatted Format the card.

Battery Empty Battery does not have 
sufficient charge for 
camera to operate.

• Replace batteries.
• Recharge batteries.
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	5. Move the 5-way button right to open the Format submenu.
	6. Move the 5-way button up or down to select Confirm to format the memory or Cancel to cancel the operation.
	7. Press OK when finished.


	Playing games on the camera screen
	1. Turn on the camera and switch to picture mode.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Games menu.
	4. Move the 5-way button up or down to highlight one of the following games:
	5. Move the 5-way button right to select the game and start playing.
	6. Press Menu to stop the game at any time.


	Reviewing photos or movie clips
	1. Move the 5-way button right or left to skip to the next or previous file.
	2. If the file is a video clip, press OK to start playing the video clip. Press OK to stop playback. Playback status is displayed on the screen, along with the playback icon.
	3. If the file is an audio clip, press OK to start playing the audio clip. Press OK to stop playback. Playback status is displayed on the screen, along with the playback icon.
	4. You can attach a voice memo to an image by pressing the Voice button. Press the button again to stop recording. To play back the voice memo, press the OK button. To learn about deleting the voice memo, see “Deleting a voice memo” on page 34.
	Zooming in
	Deleting files
	1. In playback mode, use the 5-way button to browse to the image or audio/video clip that you want to erase.
	2. Move the 5-way button down to display the Erase menu.
	3. Using the 5-way button, select one of the following options:
	4. Press OK to confirm the operation. The selected files are deleted.

	Protecting files
	1. In playback mode, use the 5-way button to browse to the image or audio/video clip that you want to protect.
	2. Move the 5-way button up to display the Protect menu.
	3. Using the 5-way button, select one of the following options:
	4. Press OK to confirm the operation. The selected files are protected.

	Editing images
	Resizing images
	1. In playback mode, use the 5-way button to browse to the image that you want to resize.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Edit menu.
	4. Move the 5-way button up or down to highlight the Resize submenu.
	5. Move the 5-way button right to open the Resize submenu.
	6. Move the 5-way button up or down to select from the resize options: VGA, 1.3M, 3.1M, or 5.0M.
	7. Press OK when finished.

	Rotating images
	1. In playback mode, use the 5-way button to browse to the image that you want to rotate.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Edit menu.
	4. Move the 5-way button up or down to highlight the Rotate submenu.
	5. Move the 5-way button right to open the Rotate submenu.
	6. Move the 5-way button up or down to select one of the following options:
	7. Press OK when finished.

	Cropping files
	1. In playback mode, use the 5-way button to browse to the image that you want to crop.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Edit menu.
	4. Move the 5-way button up or down to highlight the Crop submenu.
	5. Move the 5-way button right to open the Crop submenu.
	6. Move the 5-way button up or down to select one of the following options:
	7. Move the 5-way button right to start cropping.
	8. The cropping window is displayed on the image. Use the 5-way button to move the cropping window and select the area to be cropped.
	9. Press OK when finished.


	Deleting a voice memo
	1. In playback mode, use the 5-way button to browse to the desired image with a voice memo.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Edit menu.
	4. Move the 5-way button up or down to highlight the Voice Memo submenu.
	5. Move the 5-way button to open the Voice memo submenu.
	6. Select Delete to delete the voice memo attached to the image or select Cancel to cancel the operation.
	7. Press OK when finished.

	Using the slideshow function
	Setting the starting point
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Show submenu.
	4. Move the 5-way button right to open the Show submenu.
	5. Move the 5-way button up or down to select one of the following options:
	6. Press OK when finished.

	Setting the slideshow interval
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Interval submenu.
	4. Move the 5-way button right to open the Interval submenu.
	5. Move the 5-way button up or down to select one of the following options for the interval:
	6. Press OK when finished.

	Setting the direction
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Direction submenu.
	4. Move the 5-way button right to open the Direction submenu.
	5. Move the 5-way button up or down to select one of the following options:
	6. Press OK when finished.

	Repeating the slideshow
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Repeat submenu.
	4. Move the 5-way button right to open the Repeat submenu.
	5. Move the 5-way button up or down to select Yes to repeat the slideshow or No to display the slide show only once.
	6. Press OK when finished.

	Starting the slideshow
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to open the Play submenu.
	4. Press OK.


	Ordering prints
	Using DPOF
	1. In playback mode, use the 5-way button to browse to the desired image.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Print menu.
	4. Move the 5-way button up or down to highlight the DPOF submenu.
	5. Move the 5-way button right to open the DPOF submenu.
	6. Use the 5-way button to select Current to set the DPOF information for the current image or Reset to clear the DPOF information for the image.
	7. Press OK.

	Using Direct-Print
	1. In playback mode, use the 5-way button to browse to the desired image.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Print menu.
	4. Move the 5-way button up or down to highlight the Direct-Print submenu.
	5. Move the 5-way button right to open the Direct-Print submenu.
	6. Use the 5-way button to select Current to print the current image or Cancel to cancel the operation.
	7. Press OK.
	8. Use the 5-way button to select the Copies option and set the number of copies to be printed by moving the button left or right.
	9. Select the Print option and press OK to start printing.



	Connecting to a PC or TV
	Connecting to a PC
	Installing the software
	1. Insert the CD into your PC’s CD drive. The CD menu is displayed.
	2. Select one of the following options:
	3. Click Install to start the installation. Follow the instructions on the screen to complete the installation.

	Changing the USB setting
	1. In picture mode, press Menu to display the menu.
	2. Move the 5-way button left or right to navigate to the Setup menu.
	3. Move the 5-way button up or down to highlight the USB submenu.
	4. Move the 5-way button right to open the USB submenu.
	5. Move the 5-way button up or down to select one of the following options:
	6. Press OK when finished.

	Connecting the USB cable
	1. Turn on the camera.
	2. Connect the digital camera to the computer with the USB cable.
	3. The LCD screen displays Storage or PC camera and turns off. All camera buttons are disabled.


	Connecting to a TV
	Setting the output mode
	1. In picture mode, press Menu to display the menu.
	2. Move the 5-way button left or right to navigate to the Setup menu.
	3. Move the 5-way button up or down to highlight the TV out submenu.
	4. Move the 5-way button right to open the TV out submenu.
	5. Move the 5-way button up or down to select the NTSC or PAL option.
	6. Press OK when finished.

	Viewing images on the TV
	1. Turn the camera on and set it to playback mode using the mode switch.
	2. Connect the TV out jack on your digital camera to the audio / video input ports on your TV using the AV cable provided. The LCD screen turns off.
	3. Use the procedures described in “Reviewing photos or movie clips” on page 29 to play back the files on your camera.
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